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Introduction 

 

How to use this guide 
 
The aim of this guide is to facilitate your teaching of Cambridge International AS & A Level 
Information Technology, syllabus topic 16, Graphics creation. The guidance and activities in this 
resource are designed to help teachers devise programmes of study for graphics creation that 
provide teaching time devoted to theory work and opportunities for practical exercises.  
 

Learning objectives 
 
After reading this guide you should be able to teach the following learning objectives: 
 
16.1 Vector images 

 create a vector image that meets the requirements of its intended application and audience 
 use layers to overlap items 
 use grouping or merging tools 
 use rotation and place an item 
 use transform tools to resize 
 use selection tools to select parts of an image 
 use crop tools to crop part of an image 
 use fill tools to colour items 
 use colour gradients 
 use node editing 
 fit text to a path 
 save an image in different file formats 
 compress an image to different resolutions using file formats (including: .jpg and .png) 

to suit different media file size requirements 
 

16.2 Bitmap images 

 create a bitmap image that meets the requirements of its intended application and audience 
 use layers to overlap items 
 use rotation and place an item 
 use grouping or merging tools 
 use selection tools to select parts of an image 
 use crop tools to crop part of an image 
 use masking tools 
 use tools to improve parts of an image (including: blend, replicate, retouch) 
 use tools to remove red eye 
 use filters (including: blur, distort, sharpen) 
 convert between colour, duotone and black and white images 
 use colour gradients 
 resize an image 
 resize the canvas 
 change the opacity of all or part of an image 
 use text tools to include text 
 save an image in different file formats 
 compress an image to different resolutions using file formats (including: .bmp, .jpg, 

.png, gif to suit different media file size requirements) 

 describe the difference between a bitmap and a vector graphic 

 describe how typical features found in bitmapped and vector graphics software are used in 
practice 

 evaluate their suitability for a given scenario 
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 evaluate the impact of image editing on society (including: media, advertising, fashion, 
shopping, politics, entertainment). 
 

Prior knowledge and preparation 
 

Before you begin teaching this topic: 

 make sure that you know how to scan photographs or import photographs from a 
digital camera 

 have a basic understanding of graphics software  

 make sure that you have access to graphics packages such as Adobe® Illustrator® and 
Photoshop® or Inkscape™ and GIMP©. 



Key terms 

4 Topic support guide 9626 Topic 16 Graphics creation 

1. Key terms 

 

Word/phrase Meaning 

bitmap graphics Graphics that are defined by a matrix of pixels, each of which can be a 
different colour. 

compression The re-encoding of data into a format which uses fewer bits of 
information than the original.  This can speed up loading and transferring 
the file, and reduce the amount of memory it takes up on your computer. 

lossless 
compression 

Compression of a bitmap graphic which removes repeating patterns of 
data, but allows the original data to be exactly reconstructed from the 
compressed data. 

lossy compression Compression of a bitmap graphic which uses approximations to remove 
and discard data within a graphic that is unlikely to be noticed. 

meta-graphics Images containing a combination of bitmap and vector data. 

node An editable point on a line or vector which can be selected, transformed 
and moved. 

pixel Single unit / picture element of a bitmap graphic – a single coloured dot. 
Short for ‘picture element’. 

pixellation When a bitmap image is enlarged so much that you can start to make out 
the individual pixels from which it is made.  Edges and details lose their 
sharpness and the whole image can appear blurry or blocky. 

rasterisation Conversion of a vector graphic to a bitmap graphic (at the native 
resolution of the display device) so that the vector can be viewed on a 
display. 

resolution The amount of detail in an image, which is dependent on how many 
pixels it contains.  Measured in Megapixels, dpi, ppi, or pixel dimensions. 

resolution 
independent 

Graphics which are redrawn, when moved or scaled, at the native 
resolution of the display or output device (this applies to vector graphics). 

run length 
encoding 

A data compression algorithm, that is supported by most bitmap file 
formats, which reduces the physical size of a file by encoding a run of 
repeating characters in the file into two bytes. The first byte is the run 
length - the number of repeating characters. The second byte is the 
repeating character or value. So the 5 byte run ‘AAAAA’ could be 
represented in two bytes as ‘5A’. 

tracing Conversion of a bitmap graphic into a vector graphic. 

vector graphics Graphics that are defined by mathematical descriptions of lines and 
shapes. 
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2. Theory 

 
2.1 Introduction 
 
Bitmap and vector graphics are two different types of images used in both print and digital display. 
Although there are many occasions where the content of vector and bitmap graphics can overlap 
or appear to be the same, they are very different in terms of their data storage and image 
representation, which have distinct properties and purposes. 
 

2.2 Bitmap graphics 
 
Bitmap graphics are basically an image file which is made up of very small dots (pixels), each of 
which can be a different colour. With enough pixels all combined together, a person viewing it will 
see a picture (an image). The bitmap format is very effective at representing images which are 
reflective of the real world – for example, photographs.  
 

 
 
The image above is an example of a bitmap. In the early days of image creation, a graphic could 
only be displayed in monochrome (black and white). To represent an image, the computer simply 
switches pixels on and off, each pixel being a single bit. In the image, the letter ‘A’ is represented 
by turning off some pixels (bits) and leaving others on, creating a map. In terms of a bitmap this is 
represented by: 
 

1 1 0 1 1 

1 0 1 0 1 

1 0 1 0 1 

0 1 1 1 0 

0 0 0 0 0 

0 1 1 1 0 

1 1 1 1 1 

 
The 0s in this example have been highlighted simply to make them more obvious. This example 
would be used on a monochrome screen which is displaying black text on a white background. To 
display white text on a black screen, the bits are reversed.  
 
Using a bitmap like this makes the representation of data in terms of an image very simple, 
however monochrome graphics are not the most visually appealing. 
 
Modern screens and computer systems can display many more colours, however the principle is 
still the same. Rather than only using a single bit per pixel to create the map, more modern 

http://upload.wikimedia.org/wikipedia/commons/9/91/Bitmap_vs_vector.png
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graphics use more bits per pixel. The increased number of bits allows more data per pixel so that 
an increased number of colours per pixel can be represented. Colour on a computer screen is 
generated by combining varying levels of red, green and blue, called ‘channels’, therefore when 
representing a colour image, the number of bits available per pixel must be split equally into three 
– an equal amount of data being given to each channel. 
 

Number of bits per channel Number of colours 

1 2 (black and white) 

2 4 

3 8 

4 16 

5 32 

6 64 

8 256 

12 4096 

 
Modern computer screens don’t normally refer to the number of bits per channel, but combine the 
three channels together to give a total number of bits per pixel. For modern computer images this 
is often 24 bits – 8 bits per channel x 3 channels (Red, Green, Blue). 
 

Number of bits 
available for Red 
channel 

Number of bits 
available for Green 
channel 

Number of bits 
available for Blue 
channel 

Combined number of bits 
per pixel 

8  8  8  24 

 

Total number of 
different reds that 8 
bits can represent 

Total number of 
different greens that 8 
bits can represent 

Total number of 
different blues that 8 
bits can represent 

Combined number of 
colours per pixel 

256   256  256  16.7M (256 x 256 x 256) 

 
Having more bits per pixel means that you can display a greater number of colours per pixel (the 
‘colour depth’) which means that an image can look more realistic. The image is still just a map of 
bits, however, and if you zoom into it you will see that map – all of the individual pixels shown as 
individual dots on the screen, each one represented by a set amount of data. 

 
 

 
This can be demonstrated if we zoom into the eye of the dog image and look at one individual 
pixel, producing an effect called pixellation. 
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If we look at one individual pixel and ask a graphics application such as Adobe Photoshop to give 
us the exact Red, Green and Blue (RGB) values for that pixel, it will show us that the pixel 
highlighted above has a value of R215, G75, B170. Each of these values is 8 bits of binary (1 
byte). When combined together this adds up to 24 bits needed to represent the individual colour for 
that pixel. 
 

2.3 Resolution 
 
The ‘resolution’ of an image can have various meanings. A high resolution image can simply mean 
that it is physically big – a large number of pixels. A good example of this would be a high 
resolution digital SLR camera. A 12.1 megapixel camera, for example, takes images that are 4000 
by 3000 pixels which might be called high resolution. However, to be more meaningful, the number 
of pixels needs to be combined with a value of measurement over which those pixels (dots) are 
placed. The measurement value typically used is an inch. A 300 dots per inch (dpi) image has 300 
pixels (dots) in a line taking up 1 inch on the page. A 100 dpi image has 100 pixels (dots) in a line 
taking up 1 inch on the page. At these resolutions the naked eye may not be able to discern the 
difference between them, but technically the 300 dpi image is of a higher resolution than the 100 
dpi image. Taking this into consideration, describing a camera of 12.1 megapixels as high 
resolution isn’t strictly true: it depends on the final resolution in terms of the dpi at which the image 
it creates is being displayed.  
 

2.4 File size 
 
Since a computer has to store information about every single pixel, the file sizes of bitmap images 
are comparatively large, meaning they take up more storage space on the computer, and can take 
longer to load when you want to view or edit them. They can be compressed to make file sizes 
smaller, but this is often at the expense of some of the pixel data, which means the image will lose 
quality and could appear “blocky”. 
 

2.5 Vector graphics 
 
Vector graphics work in a completely different way to bitmap graphics. Rather than being a map of 
bits representing which pixel is switched on and which is not, and for those switched on, what 
colour they represent, a vector graphic is a mathematical description of an image. Vector graphics 
are made up of lines and shapes combined together to form an image. The coordinates of these 
lines and shapes are all stored as mathematical data: start and end points to lines, their thickness 
and the colour. The start and end points of each line are called ‘nodes’. The values for these nodes 
– the mathematical position of them within the image – are described by a relative distance from 
the origin – for example the top left hand corner of the image. This way, when the image is being 
drawn on the screen, once the computer knows the position of the origin on the screen (set by 
where the user places the image), all the other points can be calculated. To draw a line on the 
screen, the computer only needs to know the start point, end point, colour and thickness of the line 

Red channel 
level 

Green channel 
level 

Blue channel 
level 

215 75 170 

11010111 01001011 10101010 
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– it can then work out all of the points in between and draw the line. This significantly reduces the 
file size needed for an image. Whereas in the bitmap image of the dog in section 2.2 each pixel 
requires 24 bits of stored data, with a vector image the computer calculates each pixel relative to 
the start, end, colour and thickness data meaning that significantly less data needs to be stored. 
 
An additional advantage of vector graphics is that the lines and shapes can be scaled and grouped 
very easily. When a vector image is scaled, all the points are recalculated relative to the origin and 
value of the scale and then redrawn on the screen or page. This means a vector image will always 
stay smooth regardless of how much it is enlarged. 
 

 
 
Vector images do not only use straight lines – they can also use ‘Bezier curves’ to represent 
curved lines: 
 

 
In the above image a curved line is represented by four nodes: the green node on the left is the 
start of the line; the red node on the right is the end of the line; the two nodes in the middle of the 
image are ‘Bezier handles’ which ‘bend’ the line. A good way to explain this is to imagine that these 
handles are like magnets. The line is drawn starting from the green end node, but is first attracted 
towards the green handle node and then attracted towards the red handle node before finishing at 
the red end node.  
 
Moving the handle nodes will bend the line in different directions. As each node and handle is a 
mathematical value relative to the origin, the line will always remain smooth regardless of how you 
move the nodes, because the position is recalculated and the line redrawn each time. This means 
that vector graphics are referred to as being ‘resolution independent’: the resolution of the device 
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displaying or printing them doesn’t matter because the graphics are recalculated and redrawn each 
time they are scaled, moved or displayed and that redraw is at the resolution of the displaying (or 
printing) device. Vector graphics are very effective for representing line art images such as logos. 
 

2.5.1 Why don’t we use vector graphics for everything? 
 
Put simply, vector graphics don’t work as efficiently when an image contains a lot of data. 
 

          
 
Looking at the examples of bitmap and vector images above, the vector image on the right is made 
up of simple lines and shapes. Each line requires stored data for the start and end points, 
thickness and colour. The bits in between each of these points are calculated at the time of display. 
The bitmap image on the lefti uses pixels and has data associated with each one. If you tried to 
represent the left hand image as a vector, almost every individual pixel would need to be 
represented as one line, because of the image’s complexity, with data to store its start point, end 
point, thickness and colour. This is considerably more data per pixel than just the RGB value, 
making it much less efficient. 
 
It is possible using programs like Adobe Illustrator or CorelDraw to convert a bitmap image to a 
vector (known as ‘tracing’). This does a reasonable job of converting each pixel into vector data by 
using a threshold to choose how close the RGB values of adjoining pixels need to be in order for 
the computer to view them as ‘the same’ and therefore create a shape rather than trying to create 
a single line per pixel. The threshold value set when the trace is performed will affect how good the 
trace is in terms of image detail. 
 

2.5.2 Why can vector images look ‘blocky’ on the screen? 
 
This can be answered using the information on resolution in section 2.3 above. A screen is a 
bitmap display device; it uses pixels (dots). The resolution of a screen is described partly by the 
size in terms of pixels (for example 1024 pixels by 768 pixels), but also in terms of the number of 
dots per inch (dpi). Screen technology has improved from 72 dpi, typical of cathode ray tube 
monitors, to around 300 dpi used in Apply Mac Retina displays. On a lower resolution screen, with 
a lower dpi, you can see the dots. A vector image is drawn on the screen (this is called ‘rasterised’) 
at the resolution of that screen. On a lower resolution screen, you will see dots in the rasterised 
vector graphic. 
 

2.6 How are vector and bitmap graphics used in practice? 
 
Because of their different qualities, vector and bitmap graphics are used for different purposes. A 
vector graphic, represented by lines and shapes, is more suitable for ‘simpler’ images such as 
maps and logos which are typically bold, simple and striking. (The word ‘simple’ is used here to 
describe the complexity of the image detail and not the aesthetic appeal of the image). Bitmap 
images are used whenever there is a need for an image to show a realistic representation of 
something in the real world, for example a photograph. The two types of graphics are often used in 
combination, for example a vector logo over the top of a bitmap photo, to gain the benefits of each 
graphics format. 

https://upload.wikimedia.org/wikipedia/commons/6/67/Cake-shaped_earrings.jpg
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3. Graphics creation tasks 

 

3.1 Vector images  
 

To demonstrate different tools in vector applications, an effective way is to draw a repeating 
symmetrical shape which primarily uses straight lines. A good example of this is a snowflake. This 
example will enable you to draw a snowflake and then place it onto a gradient background with text 
to create a greetings card. 

 

3.1.1 Use node editing 

 

Adobe Illustrator 

 
 
 
 
 

As explained in section 2.4, vector graphics are made up of lines and shapes which in turn are 
made up of nodes. The hexagon in the graphic above is just six nodes with the mathematical 
instruction to draw a joining line between them. The line on the right is the same, but only needs 
two nodes. This is going to be the basis of our image. 
 
Click and hold on the ‘Shape’ tool in the toolbar on the left and select 

‘Polygon Tool’  

 

 

 

 

Click in the middle of your page. This will display the 

options for a Polygon. Set the Radius to 30 and the Sides 

to 6. Click OK to draw your polygon. In the path bar at the 

top of the screen, set the Stroke to 10. This will thicken up 

the line. 

 

Click and hold on the ‘Shape’ tool again and select 

‘Rounded Rectangle’. 

Click on the right hand corner of your polygon. This will 

display the options for a rounded rectangle. Set the Width 

to 200, the Height to 5 and the Corner Radius to 12. 
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With ‘Rounded Rectangle’ selected, use the cursor keys to 

shuffle it into place on the edge of the polygon, so you get 

something similar to the image on the right:  

 

 

Click on the ‘Shape’ tool again in the main toolbar and 

then click to put another, smaller, rounded rectangle onto 

your page, but this time with a Width of 75, Height of 5 

and Corner Radius of 12.  

 
 

 
 

3.1.2 Use rotation and place an item 

 

Adobe Illustrator 

 
 
 
 
 

In the main toolbar, click and hold on the Rotate Tool and make sure that 

‘Rotate Tool’ is selected. 

Hold down the ‘Shift’ key on the keyboard and then click on the smaller 

shape you have drawn and rotate it round by one step. You should have 

something which looks similar to the image on the left below.  

Now use the cursor keys to shuffle the smaller piece into place so that it 

looks similar to the image on the right. 
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3.1.3 Use selection tools to select parts of an image 

 

Adobe Illustrator 

 
 
 
 
 

Copy and paste the smaller shape three more times and use 

the cursor keys or mouse to shuffle them around into the 

pattern you want to have for your snowflake. Something 

similar to the image on the right produces a nice effect. The 

‘pattern’ is only the bit which appears ON TOP of the line. In 

the next step we are going to cut off underneath the line.  

 

Select all four of your ‘branches’ by clicking on the first one, 

holding down ‘Shift’ on the keyboard and selecting the others.  
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3.1.4 Use crop tools to crop part of an image 

 

Adobe Illustrator 

 
 
 
 
 
 
 

Click on the Windows menu at the top of the screen and select 

‘Pathfinder’. This will display the Pathfinder menu. 

 

With the four branches still selected, click the ‘Unite’ button. This 

will combine the branches into one shape. 

 

Draw a normal rectangle over the top of the lower half of your 

branches so it looks similar to the image on the right. You are 

going to use this to cut the branches. Make sure it covers the 

whole of your branches. 

 

Make sure that your rectangle is selected, then hold down 

‘Shift’ on the keyboard and select your branches. (Both the 

rectangle and the branches have to be selected for this step to 

work.) Click the ‘Minus Front’ button in the Pathfinder menu. 

 

This will chop off the bottom half of the branches. It should now 

look a bit like a key. 

 

Make sure that the branches are selected, and click the 

‘Expand’ button in the Pathfinder menu.  Now we need to do 

the other side of the branch. 
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3.1.5 Use grouping or merging tools 

 

Adobe Illustrator 

 
 
 
 
 

Click and hold on the Rotate Tool in the toolbar and select ‘Reflect Tool’.  
 
Hold down the ‘Alt’ key on the keyboard and click on the branches of your 
snowflake. 
 
 
Make sure that the ‘Horizontal’ option is selected and then click 
‘Copy’. (Just clicking ‘OK’ will not make a duplicate.) 
 
 
 
 
 
 
Use the cursor keys to shuffle the lower branches into place 
underneath the top ones. You should have something similar to 
the image on the right.  
 
Hold down ‘Shift’ on the keyboard and select the upper branches 
AND the original rounded rectangle that you made (this can be a 
little tricky to do). Make sure you DON’T select the polygon. 
 
 
 
Making sure that you have got all three parts selected, 
click the ‘Unite’ button in the Pathfinder menu.  
Then click the ‘Expand’ button to build the shape. 
 
When you click on your branch now you will see that it is all one shape which makes it easier to 
work with. 
 
 
Click on the Rotate Tool in the main menu and then hold down the ‘Alt’ key 
and click on the branch you just made. In the Rotate menu, put Angle to ‘60’ 
and click ‘Copy’. This will make a copy of your branch, but rotated for the next 
corner in the polygon. Repeat this process until all six corners are done. Use 
the mouse and cursor keys to shuffle the branches into place.  
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You should now have a 
finished snowflake! 
 
You can use the same 
technique for drawing 
trees and other 
decorations. 
 
 
 
 
 

 

3.1.6 Use colour gradients and use fill tools to colour items 

 

Adobe Illustrator 

 

 
 
 
 

Now it is time to put our snowflake over the top of a wintery 
background. Click on the Selection menu and choose ‘Select 
All’. This will select all of your snowflake. Then right click and 
choose ‘Group’ to combine your snowflake into one object. 
This will make it easier to work with.  
 

 
 
Click on the Rectangle Tool in the toolbox on the left hand side 
of the screen (keyboard shortcut: M) and draw a box over most 
of your page. This will become the background. 
 

 
Double click on the Gradient Tool in the toolbox on the left hand 
side of the screen (keyboard shortcut: G). This will display the 
Gradient tab. Change the ‘Type’ to ‘Linear’ and the ‘Angle’ to ‘90’. 
This will give us a top to bottom gradient.  
 
Underneath the colour gradient rectangle in the middle of the tab 
you will see small colour boxes. These are the colours of the  
gradient. You can drag them around to change the main colour 
points of the gradient. If you double click on one of the small colour 
boxes you can change the colour selected at that point in the 
gradient.  
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Change the colours and positions to match the image on the right. The exact colour isn’t really 
important if you prefer to use different colours.  
 
You should see that the box you drew earlier has changed to a colour gradient. 
 

 

3.1.7 Use layers to overlap items 

 

Adobe Illustrator 

 

 
 

Select the rectangle you have just created and then 
right click on it. From the Context menu which appears, 
select ‘Arrange’ and then ‘Send to Back’. This will put 
the gradient box behind the snowflake image.  
 
Layers in vector graphics applications work in the same 
way as in other applications, with different images 
appearing on top of each other. You can use the 
Arrange menu to change the order of these in order to 
create the effect you need. 
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3.1.8 Use transform tools to resize 

 

Adobe Illustrator 

 
 

 
To ‘Transform’ an object in Illustrator choose the Selection Tool in the toolbox on the left hand side 

of the screen (keyboard shortcut: V) and then click on your snowflake. Because you grouped it 

earlier on it should select as one object. Click and drag on the white ‘Select’ handle in the bottom 

right hand corner of the snowflake. If you hold down the ‘Shift’ key on the keyboard this will ensure 

that the object’s proportions stay the same. If you hold down the ‘Alt’ key at the same time, the 

scale will originate from the centre of the snowflake 
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3.1.9 Fit text to a path 

 

Adobe Illustrator 

 

 
 

 

 
Choose the Ellipse Tool in the toolbox on the left hand side of the screen (keyboard shortcut: L) 

and draw a circle above your snowflake. Hold down the ‘Shift’ key on the keyboard to ensure that 

the circle is uniform. Don’t worry that it fills with a solid colour – this will be corrected in a moment.  

 

Choose ‘Type on a Path Tool’ from the toolbox on the left hand side of 

the screen. To select this, click and hold on the Type Tool in the 

toolbox to display the additional options.  

 

 

Imagining that your circle is a clock face, click on the edge of the circle at roughly the 9 p.m. mark. 

This will be where your text will start. Type in ‘Season’s Greetings’. This technique for typing on a 

path works with any shape. If the text does not line up as you expected you can rotate the circle 

using the Selection Tool to get the text to the angle you would like. 
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3.1.10 Save an image in different file formats 

 

Adobe Illustrator 

 

 
 

When you are happy with your greetings card you can save it as an 

Illustrator file. This will retain all of its editable nodes. Unfortunately, 

however, not many applications can open or use Illustrator files, 

therefore it may be useful to save the document in a different file 

format. To do this, click on the File menu and choose ‘Export’. 

 

In the ‘Save as Type’ dropdown menu you have a number of 

different choices, depending on the destination of the image you 

have just created. A brief table of the advantages of disadvantages 

of some of the main formats is shown below: 

Format Advantage Disadvantage 

.wmf / .emf Very good, generic vector file 
formats which can be viewed by 
most Windows applications. 

These formats are getting a little 
old and may not accurately 
represent more complex vector 
graphics. 

.eps Generic vector format, typically used 
for printing. 

Some lower-end applications may 
not be able to open them. 
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3.2 Bitmap images 
 

To demonstrate different tools using bitmap images, these tasks use the example of ‘head 
replacement’ – putting one person’s head onto another person’s body. This can be an excellent 
task for learners to undertake, especially if they have been allowed to take their own photographs 
as the source material. To use this idea, learners must first find a background image – the person 
they want to ‘put their head onto’ – for example bands, famous people, or cartoon characters. They 
must also take a photograph of themselves to use. To make the image most effective, they should 
attempt to match the angle and lighting of the original background image. This will make the final 
composition look more realistic. 

3.2.1 Use crop tools to crop a picture 

 

Adobe Photoshop GIMP 

 
 

 
 
 

 
 

 

Shown here is our example head shotii. The area around the outside of the photo is not needed 
and can be cropped from the picture using the cropping tool.  
 

  
 
In Photoshop, click the Crop Tool in the toolbar on the left hand side of the screen (keyboard 
shortcut: C). In GIMP, click the Crop Tool in the toolbox (keyboard shortcut: Shift + C). 
 



Graphics creation tasks 

 Topic support guide 9626 Topic 16 Graphics creation 21 

          
 
Use the white handles to crop the image down to the area you need. Be careful not to crop too far 
and remove parts of the image which you still need. When you are happy with your crop, press the 
‘Enter’ key on the keyboard to accept it. In GIMP you will need to save your file at this point under 
a new name so that it can be layered in the next task. 
 

 
 

3.2.2 Use layers to overlap items 

 

Adobe Photoshop GIMP 

 

 
 

 
 
 

 

 
Load the image that you want to place your ‘head’ onto (the example here is a group photoiii). At 
the top of the screen in Photoshop you will see tabs – one for each image which has been loaded. 
Click on your ‘head-shot’ image, choose ‘Select All’ from the Selection menu and then copy and 
paste your ‘head-shot’ image onto your ‘group shot’ image. This will use layers which are shown on 
the right hand side of the screen. To make your graphic easier to work with, you can rename your 
layers by double clicking on the current layer name. 
 
In GIMP click on the ‘File’ menu and select ‘Open as Layers’ and then choose the image which you 
saved in the previous task. 
 



Graphics creation tasks 

22 Topic support guide 9626 Topic 16 Graphics creation 

An effective way of describing layers is to imagine that each one is a piece of acetate sheet placed 
one on top of another. The image at the top of the pile of sheets is the one you can see, and 
overlaps and obscures anything behind it. Where there is no image, you can see the layer 
underneath. In the above example you can see that the ‘head-shot’ does not take up the full width 
of the group shot image underneath it, therefore it overlaps and obscures only part of it. This 
means that you can create a multi-layer image using component parts. The benefit of this is that 
each layer is individually editable without being destructive to layers above or below, which makes 
editing more powerful.  
 

 

3.2.3 Use selection tools to select parts of an image 

 

Adobe Photoshop GIMP 

 

 
 

 
 
 

 

There are multiple selection tools in graphics applications to help you to select part of the image. 
These include ‘marquee’ tools (typically both round and rectangular) and ‘lasso’ tools (typically 
freeform, but can also be polygonal and magnetic).  
 

 
 
  
Most applications also have a ‘magic wand’ tool which can select large areas of single or similar 
colour using a tolerance setting for how close the range of colours need to be to each other.  
 
To make our ‘head-shot’ work we need to remove the background so that you can see the layer 
underneath. If the image you are using has a solid background then you can use the ‘magic wand’ 
to do this. For this example, this will work because the background is white. 
 

   
If the source material has a textured background, then you will need to use different tools. In 
Photoshop, click the Lasso Tool in the toolbar on the left hand side of the screen (keyboard 
shortcut: L). In GIMP it is called the ‘Free Selection Tool’ (keyboard shortcut: F). Draw around the 
head in your head shot to select it, making sure that the shirt is not selected. To do this effectively 
requires some practice and a steady hand. 
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3.2.4 Use masking tools 

 

Adobe Photoshop GIMP 

 

 
 
 
 

 
 

 

 

 
 
With the head shot selected, click the ‘Layer Mask’ button at the 
bottom of the ‘Layers’ tab on the right hand side of the screen in 
Photoshop. In GIMP, right click on the layer and select ‘Add Layer 
Mask’, and then choose ‘Selection’ from the list of options to initialise 
the layer mask. Click ‘Add’ to confirm. This will add a grayscale layer 
mask to our ‘head-shot’ as can be seen in the example above: where 
the layer mask is black, the layer is transparent, where it is white, the 
layer is opaque. The layer mask can be painted on using normal 
brush tools. Painting in grey creates a semi-transparent section of the 
layer.  
 
The benefit of masking tools is that they allow you to remove parts of an image/layer but in a non-
destructive way: although those parts of the image are not shown, they are still there and can be 
‘unmasked’ by removing the layer mask or painting back in the parts that you need. This is 
considerably more powerful than using the Eraser Tool which is destructive.  
 
You can choose between working on the layer mask for an individual layer, or the actual layer 
itself. To work on the layer itself, click on the small thumbnail in the layer on the right hand side of 
the screen. To work on the layer mask, click on the small black and white mask thumbnail. The 
selected option is highlighted. 
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3.2.5 Resize an image, use rotation and place an item 

 

Adobe Photoshop GIMP 

 

 
 
 
 

 
 
 
 

 

The final part of our head replacement is to scale and rotate the picture 
of the head shot so that it fits correctly on the background.  
 
In Photoshop, click on the Edit menu and select ‘Free Transform’ 
(keyboard shortcut: CTRL + T). Using the square handles on each 
corner, scale the picture of the head down so that it is the correct size 
for the background. To make sure that the picture’s proportions stay the 
same, hold down the ‘Shift’ key on the keyboard while doing this. To 
rotate the head shot, move the cursor near to one of the corner handles 
of the transform square. As the cursor moves towards the handle it will 
change the curved icon. Clicking at this point will allow you to rotate the 
image around the centre point of the transform square.  
 
 
 
 
 
In GIMP, click on the Layer menu and select ‘Scale Layer’. 
Enter the new size you would like the layer to be – for this 
example, about 120 pixels in width is fine. Once your head shot 
layer has been scaled, use the Move Tool in the toolbox 
(keyboard shortcut: M) to move the head shot layer into place. 
 
 
To change the point the image rotates around, click on the small 
circle in the middle of the transform square and move it. This is 
the centre of the rotation. 
 
When you are happy, press ‘Enter’ on the keyboard to place the image. Use the paintbrush on the 
layer mask for the head shot to paint out any parts which you don’t want. 
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3.2.6 Save an image in different file formats 

 

Adobe Photoshop GIMP 

 

 
 

 

 

To save our final image, in Photoshop, click on the File menu and select ‘Save As’. This will display 
a save dialogue and ask you where you would like to save your file.  In GIMP, select ‘Export 
Image’. Click the Format dropdown menu to choose the file format you would like to use. 
 

 
 
Different graphics applications have different available formats, both native and generic. A brief 
table of the advantages and disadvantages of some of the main formats is shown below: 
 

Format Advantage Disadvantage 

.bmp Generic format, can be opened/viewed 
by most applications. 

Can use run length encoding to 
compress the file (lossless), but 
generally doesn’t compress well. 

.jpg Compresses very well and is a generic 
format which can be opened/viewed by 
most applications. 

Uses lossy compression which is 
destructive. 

.png Compresses well and can display up to 
48-bit colour. 

Some applications can’t open this 
format. 

.gif Can be used for animation. Can only use 8-bit colour. 

 
 

 

  



Graphics creation tasks 

26 Topic support guide 9626 Topic 16 Graphics creation 

3.2.7 Use tools to remove red eye 

 

Adobe Photoshop GIMP 

 

 
 
 

 

 

 
Red eyeiv is a simple problem to fix in most modern 
graphics applications. 
 
In Photoshop, click on the Healing Tool in the toolbox on 
the left hand side of the screen (keyboard shortcut: J) 
and select ‘Red Eye Tool’ from the submenu.  
 

 
 
At the top of the screen the red eye tool options will appear. These allow you to adjust the size of 
the pupil relative to the rest of the eye and how much you want to darken the eye by, expressed as 
a percentage. The default settings will usually achieve the effect you want, but if not you can adjust 
these settings to suit. Drag a box over one of the eyes, making sure that you cover the whole of the 
eye. This should remove the red eye. If it does not, you may need to undo and try again, selecting 
a different amount of the pupil. 
 
In GIMP, click on the Rectangular Selection Tool 
in the toolbox (keyboard shortcut: R) and drag a 
box over one of the eyes. Then click on the Filters 
menu, choose ‘Enhance’ then ‘Red Eye Removal’ 
from the submenu. 
 
The settings in GIMP are similar to those in 
Photoshop: they adjust how much you want to 
darken the eye and the size of the pupil. 
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3.2.8 Use tools to improve parts of an image (including: blend, replicate, retouch) 

 

Adobe Photoshop GIMP 

 

 
v 

 

 

 
Graphics applications have many tools to retouch and improve images. Good tasks to demonstrate 
this include correcting an old photo to remove scratches, or painting a reflection of someone out of 
a mirror to create a spooky image. Both of these examples use the ‘Rubber Stamp’ / ‘Clone’ tool to 
replicate and retouch part of any image. This example involves removing unwanted elements of a 
photo. 
 

   
 
In Photoshop, select the Clone Stamp Tool from the toolbox on the left hand side of the screen 
(keyboard shortcut: S). In GIMP, use the Clone Tool from the toolbox (keyboard shortcut: C). 
 
Use the Settings tools which appear at the top of the screen in Photoshop or in the Tool Options in 
GIMP to ensure that the brush size is not too big for the image you are working with.  
 
In Photoshop, hold down ‘Alt’ on the keyboard and click the mouse on one of the corners of a brick 
join in the image, ensuring that you are a reasonable distance away from the element you want to 
remove. In GIMP the process is the same, but instead hold down the ‘Ctrl’ key. This is the 
Originating Point – the point in the image which you want to ‘Replicate’ from. The reason for using 
a corner of a brick is that it makes it much easier to line up the replication. 
 
Move the cursor to another corner brick join near to the 
element you want to remove and click and paint. You 
should see a copy of the originally selected point being 
painted over the newly selected point. If you have lined up 
your two corners correctly the bricks should line up. 
 
Although this technique works on any image, having a 
replicating background such as a brick wall makes the 
process much easier to practise on. The trick to making it 
work is ensuring that the two points accurately line up. You 
may have to select an ‘Originating Point’ multiple times to 
complete the process. 
 



Graphics creation tasks 

28 Topic support guide 9626 Topic 16 Graphics creation 

3.2.9 Use colour gradients, and filters (including: blur, distort, sharpen), change the opacity 

of an image 

 

Adobe Photoshop GIMP 

 

 
 
 

 

 

 
Graphics applications often have hundreds of different filters which can be applied to an image, 
many of which can be applied together. In this example we are going to change the colour of the 
watervi.  
 

  
 
Select the Lasso Tool from the toolbox on the left hand side of the screen. In Photoshop, at the top 
of the screen change the Feather edges Radius to 5 and ensure that ‘Antialiasing’ is switched on. 
In GIMP the settings are the same, but are in the Tool Options at the bottom of the toolbox. 
 

 
 
 

 
 
 
Draw a selection around the water, but do not include the water cascade. You do not need to be 
completely accurate with this. 
 
In Photoshop, click the New Layer button at the bottom of the Layers tab on the right hand side of 
the screen. In GIMP, the New Layer button is in the Layers tab on the right of the screen. 
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In Photoshop, click and hold on the Fill Tool in the toolbar 
on the left hand side of the screen. Select ‘Gradient Tool’ 
from the submenu (keyboard shortcut: G). 
 

 
 
In GIMP, click the Blend Tool (keyboard shortcut: L) to display the 
gradient options. Either use one of the existing gradients or click 
the small pen icon on the right hand side of the Tool Options to 
create your own gradient.  
 
 
 
 
 
 
 
 

 
 
The gradient in Photoshop is from the foreground colour to the background colour, shown in the 
colour swatches towards the bottom of the toolbox. Double click on each of these to set the start 
and end colours for your gradient. 
 
 
 
Click and drag your gradient onto the water. It should 
only fill the space in the newly created layer. 
 
 
 
 
 
 
 
To make the image look more realistic, change the ‘Opacity’ of the newly created water layer to 
around 50% so that it becomes partially transparent.  
 
 

 
 
 
 
 
 
 
 

 
 
 
 
Click back on the original image layer. 
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In Photoshop, click on the Filter menu and select ‘Distort’ 
and then ‘Ripple’ from the submenu. 
 
Adjust the options to add ripple to your water to make it look 
more turbulent. When you are happy with the effect, click ‘OK’ 
 
 
In GIMP, the settings are very similar: 
 
 
 
 
 
 
 
 
 
 
 

 

3.2.10 Convert between colour, duotone and black and white images 
 

Adobe Photoshop 

 

 
 

 
Graphics applications often support different colour depths, enabling you to create custom effects. 
One of these effects involves adjusting the number of colours or tones which are available to 
display the image.  
 
Using the lizard imagevii, click on the Image menu and 
select ‘Mode’, then ‘Grayscale’ from the submenu. 
Photoshop may ask if you if you want to flatten the image if 
it is multi-layered and will ask you to confirm that you want 
to remove all of the colour data.  
 
Click again on the Image menu and select ‘Mode’, but this time choose ‘Duotone’ from the 
submenu. 
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A duotone is a reproduction of an image, but only 
using two colours – typically black and one other. 
This gives the image a hue of the colour you have 
chosen. This effect was typically used in 
newspaper and cartoon prints to give an image a 
hint of colour, but without the cost of a full colour 
print. Full colour printing is more common in 
modern print, but duotone is still an effective 
option.  
 
 
 
The colours can be set to the learner’s preference, 
however in this example, Duotone has been set to 
Black and Green, which colours the lizard image 
with a green hue. 
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4. Further resources 

 
https://photographylife.com/camera-resolution-explained 

Image and camera resolution explained. 
 
http://www.freedigitalphotos.net/ 

Huge library of digital stock photography. 
 
https://www.gimp.org/docs/ 

Help documentation for GIMP. 
 
https://www.vectorstock.com/free-vectors 

Free vector images. 
 
http://www.brandsoftheworld.com/ 

Vector logos of companies from all over the world. 
 

https://photographylife.com/camera-resolution-explained
http://www.freedigitalphotos.net/
https://www.gimp.org/docs/
https://www.vectorstock.com/free-vectors
http://www.brandsoftheworld.com/
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5. Further study 

 
While vector and bitmap graphics have their own uses, they can be combined together to make 
very effective images. Learners can review some of the stock photos available at the link below to 
see if they can combine two different images together. This works well to combine logos into a 
bitmap image, as well as to create unusual vector environments and place photographs of people 
into them. 
 
http://www.istockphoto.com/article_view.php?ID=489 
 
It is recommended that learners be encouraged to research the following questions independently: 
 

1. Summarise the key differences between bitmap and vector graphics. 
2. Describe the different attributes and uses of the commonly-used file types for both bitmap 

and vector images. 
3. Harry has been given an old photograph to restore, which has tears in the edges, marks on 

the surface, and is faded in places.  Should he use bitmap or vector graphics software for 
this task, and why? 

4. Elsbeth wants to draw cartoon versions of her friends, which she plans to use for a big 
poster, and small badges.  Should she use bitmap or vector graphics software for this task, 
and why? 

5. What are some situations/applications where bitmap and vector graphics can be 
combined?   

 
The following pages contain worksheets and additional graphics tasks that can be used to extend 
and consolidate learners’ knowledge of graphics. 
 
  

http://www.istockphoto.com/article_view.php?ID=489
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Name:_______________________ 

Target audience: 

Explain what you think the target audience is for this image? Who is it aimed at and why? 

 
viii 

 

Purpose: 

What is the purpose of this image? Explain why you think this. Explain if you think it is a vector or 

bitmap and give reasons for why the author might use that file format. 

ix 

 

Research task: 

Explain the Rule of Thirds. Use the example image below to help your explanation 

x 

 
 

  

___________________________________________

___________________________________________

___________________________________________

___________________________________________

___________________________________________

___________________________________________

___________________________________________ 

___________________________________________

___________________________________________

___________________________________________

___________________________________________

___________________________________________

___________________________________________

___________________________________________

___________________________________________ 

___________________________________________

___________________________________________

___________________________________________

___________________________________________

___________________________________________

___________________________________________

___________________________________________

___________________________________________ 

https://upload.wikimedia.org/wikipedia/commons/4/46/Khaal_tome01.jpg
https://upload.wikimedia.org/wikipedia/commons/e/e0/Typical_Boiling-Water_Reactor.jpg
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Name:_______________________ 

Image file types 
 

File type Description Bitmap or 
Vector? 

.fhd .fhd files are created in Adobe Freehand and 
are used to create drawings, illustrations and 
page layouts using shapes and lines. 

Vector 

.png 

  

.gif 

  

.bmp 

  

.jpg 

  

.svg 

  

.tif 

  

.psd 

  

.cdr 
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Graphics tasks 
 
These tasks are designed to be undertaken as a learning process covering most of the objectives 

listed at the start of this document. Learners should be encouraged to use the tasks to explore the 

menu items and tools available in the image manipulation software. 

 

Often there is more than one way to satisfy the requirements of the task. At first, the exercises 

should be about exploring a variety of options and not about determining the most efficient 

methods. 

 

Task 1 

1. Open the Red-eye.jpeg image and use 
the relevant tools to remove the red 
eyes. 

2. Change the size of the image to 600px 
wide, with constrained proportions. 

3. Export as a .png file. 

Task 2 

1. Open the Crowd-at-concert.jpeg image, 
and type the words “LIVE TONIGHT”.  
Choose an appropriate size and font, 
change colour to red and position 
centrally near the top of the image. 

2. Type the words “Sold out!”, choose a 
suitable font in a smaller size than “LIVE 
TONIGHT”, and position the new text so 
that it overlaps the end of the previous 
text, at an angle. 

3. Create a semi-opaque spiral gradient on 
the image. 

 

Task 3 

1. Open the Guitars.jpeg image and crop 
the “Flying V” guitar (the one on the left) 
from the image. 

2. Using the relevant tools, first get rid of 
the background, then create a larger, 
blurred version of the guitar and position 
it behind the original and offset slightly so 
that it looks like a shadow. 

3. Place both of these at the top left corner 
of the image, at a 45 degree angle. 

Task 4 

1. Create a white border around the image.  
First increase the canvas size to 1750 px 
wide, with constrained proportions. 

2. Then create a completely white 
background layer behind the rest of the 
components of the image. 

3. Save the image as a .jpeg, at 75% quality. 

Task 5 

1. Open Eiffel_Tower.jpeg image, and 
improve it by increasing the sharpness. 

2. Use the relevant tools to remove the 
clouds from the image, so that the sky 
looks clear.   

3. Create a duotone version of the image, 
and export as a .png file. 

Task 6 

1. Open original Eiffel_Tower.jpeg image, 
and make it black and white.   

2. Using the relevant tools, apply a filter of 
your choosing to the image. 

3. Export in a 32-bit bitmap (.bmp) format. 

Image files provided: - Red-eye.jpegxi, Crowd-at-concert.jpeg, Guitars.jpeg, 
Eiffel_Tower.jpegxii. 
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Image sources 
All images are the author’s own except for those listed below: 
i Lots of cakes. From [http://flickr.com/photos/jujuly25/370986806/ Flickr] 
ii Ctaske (Own work) [CC BY-SA 4.0 (http://creativecommons.org/licenses/by-sa/4.0)], via 
Wikimedia Commons 
iii Andrew Malone (Group shot) [CC BY 2.0 (http://creativecommons.org/licenses/by/2.0)], via 
Wikimedia Commons 
iviv http://photoshop-tutorial.org/photo-effects/how-to-remove-red-eye/ 
v FiddleStix1217 (Own work) [CC BY-SA 4.0 (http://creativecommons.org/licenses/by-sa/4.0)], via 
Wikimedia Commons 
vi MartinThoma (Own work) [CC0], via Wikimedia Commons 
vii Chris_huh (Own work) [GFDL (http://www.gnu.org/copyleft/fdl.html) or CC-BY-SA-3.0 
(http://creativecommons.org/licenses/by-sa/3.0/)], via Wikimedia Commons 
viii

 Valentin Sécher (Blog de l'auteur) [CC BY 3.0 (http://creativecommons.org/licenses/by/3.0)], via 
Wikimedia Commons 
ix
 Nuclear Regulatory Commission from US [CC BY 2.0 

(http://creativecommons.org/licenses/by/2.0) or Public domain], via Wikimedia Commons 
x
 Chaky (Own work) [Public domain], via Wikimedia Commons 

xi By User:PeterPan23 (Own work (Original text: self-made)) [Public domain], via Wikimedia 
Commons 
xii By Benh LIEU SONG (Own work) [CC BY-SA 3.0 (http://creativecommons.org/licenses/by-
sa/3.0)], via Wikimedia Commons 
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